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Introduction 

 

There is no doubt that Microsoft Office Word is one of the most used packages around the 

world, and the new, updated Office 10 package is something that has led to great 

expectations. Word is a well-presented and versatile package as it stands, and any 

improvements will have to take the already present aspects of the package and add to it. 

Some may find the changes difficult to get used to, but Microsoft is confident the new 

package is a major improvement over the existing version. 

The new version of Word is different from the previous incarnations in many ways, and the 

main talking point has been the inclusion of a web based version. We will cover this in more 

detail later on and look at the pros and cons of the system overall, but suffice to say that there 

has been a concerted effort to keep the neat and stylish look of the Desktop version while 

giving users something new. 

The Ribbon is the interface of choice and while it met with some criticism in earlier versions 

it is revised and more user friendly here. Another major change to the Office 10 version of 

Word is the manner in which multiple users can edit the same document. This allows for 

greater versatility and ease of manipulation while also incorporating a security protection 

system that guards against mishaps. 

Real time notifications keep users informed of amendments being made by others – a neat 

touch that aids the smooth operation of the system – while improvements to the copy and 

paste functions have made things much easier to handle. These improvements provide a 

useful preview of the impending paste and also a fresh approach to amending more complex 

documents that are aimed at improving handling of larger text portions. This is aided by a 

new ‘Navigation Pane’, an addition that allows for different sections of the document – the 

header, footer and main content for instance – to be moved around separately. 

 

The Office Web functions are another area that will be enhanced by the inclusion of the 

multiple user amendment facility. The versatility of the new version cannot be 

underestimated, and while simple tasks remain the same there is much to be said for 

improving the way in which documents can be changed from different locations. 

Microsoft states that its main aim has been to ease the use of multi-user documents and to 

install the browser versions, and also that it will be streamlining the popular versions of the 

package down to an available five packages from the previous eight. This, of course, allows 

for less complications and more immediate comparison, and should result in greater 

understanding of the improvements all round.  

Office 10 is available to run on all major browsers, and the main purpose of this eBook is to 

look at the way in which some of the simple and more complex tasks are undertaken. It is 



expected that the Web based version will be popular with students, but the business world 

will also be interested in these new features. The question is, how easy is it to use? 



Chapter 1: Basic Features 

 

The basic features of Microsoft Word should be familiar to many, but for new users let’s 

have a look at the way the Office 10 version is used to create and format documents, and go 

through some basic features of the system. 

Opening Office Word will provide you with a new document each time, a basic blank 

document that looks like this: 

 

This is your starting point, the basic document ready for your input. Type some text into it 

and you will see it appearing on the page. The standard settings are always the same unless 

you change them.  

Below is a screenshot of word that shows the basic features across the top and a sample 

document in production. 

 

The first thing to discuss is how to create a document from scratch: 

Create a Document 

The basic process for creating a document is simple. If you select Word on your desktop you 

will be presented with a blank document of the style above – without the text and with the 

toolbars – and you are free to work with that document and type in what you wish. 

Along the top you have several tabs; at this first instance you will be in the ‘Home’ section, 

and it is here that you can choose the basic modes of presentation that you want to use on 

your document.  

You are free to choose from a variety of fonts, font sizes and colors, and below the font name 

you can see buttons for the major highlighting functions used in documents – B for bold, I for 

italics and U for underline. Selecting any of these will ensure that everything following that 

point in the document corresponds with your instruction. For instance, if you press B now the 

copy that follows will be bolded; if you now press U it will also be underlined. When you 

press both B and U again you revert to standard type. 

The simplicity of this system applies also to many other functions including headings, line 

spacing and more, and the versatility of Word in Office 10 is not to be underestimated. 

Copy and Paste 

The ability to copy text, pictures and more and paste it to another document makes Word a 

versatile package, and therefore a brief explanation of copying is helpful. 



The best way to copy material is to highlight it using your mouse and then press Ctrl+C; this 

commands all of that text to be placed on the clipboard. If you now place your cursor at the 

place you want to copy it to – and this could be another position in the original document or a 

new document entirely – and press Ctrl+V it will appear in the position required. Note, 

however, that it is not deleted from its original position with this process. 

You can also copy an entire document with a few simple clicks; Ctrl+A will highlight the 

entire text of the document that you are in and following this with Ctrl+C – as above – allows 

the whole document to be copied. It can then be added to a document or reproduced 

elsewhere using the Ctrl+V function. 

The Spell Checker 

One of the most important aspects of Word is its ability to check spelling, and it can do so 

with some accuracy including attention to grammar and advice on certain errors with 

suggestions. Any words spelt incorrectly are highlighted as such, and the built in dictionary 

can be added to by the user. 

There are several facets of the spell check facility that are useful and powerful, and here we 

will look at a couple of these to show how simple this facility is. 

If you refer to the earlier illustration there is a tab titled ‘Review’; this is where the spell 

check is found. If you click Review you will be presented with many buttons – a menu that is 

quite comprehensive and mostly self explanatory. 

At the left you will see a large ‘ABC’ – this is the spell check facility. When you have a 

document open and the cursor on it you simply click the ABC button and the system 

performs a check on the entire document, highlighting errors and giving you a box in which 

to correct them – as below. 

 

 

The spell check takes each error or query individually; above we see a spelling mistake with 

the options ‘Ignore Once’ – useful for brand names or other one-off actions – and Ignore 

Rule, for common errors or other frequent occurrences, plus the option of moving on to the 

next sentence or alternatively ‘Change’ . If you select the latter, the word or phrase will 

automatically be changed to the alternative shown in the box on the left; if there is more than 

one option, the user selects the right one and presses Change. The accuracy of the system is 

very good, although inevitably there will be some that are not 100% correct. 

An additional feature of the spell checker that is very useful is the ‘Set Language’ feature, 

found to the right of the ABC icon and those next to it. If you select this function you will be 

offered several languages, with English in two versions – American and UK. The differences, 

as you will be aware, are subtle but this does allow you to produce text suitable for an 



American audience and a version that will read better for UK readers, an important 

distinction in many business documents. 

Set text justification 

Another basic feature is the ability to set the position of the text on the page; it can be centred 

or set with left bias – the four selections are in the ‘Home’ section and are shown to the right 

of those that change the color of the text.  

Using this system you can design your document as you wish, and differentiate between a 

letter style with left bias or a table style with centre bias. Let us have a look at an example of 

the same text in two different settings: 

 

 

The above shows the standard letter style document with the bias to the left margin. When 

you select all the text – the CTRL + A button will highlight it all – and select the alternative 

centre bias for the document you will see the following: 

 

The difference is plain to see, and the above version is ideal for use on such as menu’s and 

other list style documents. 

Page Break 

Returning to the ‘Insert’ tab we can also take a look at the Page Break function. The icon for 

this is found on the left of the top of the screen menu, and it is used to create the end of a 

page where the natural break should be. If you type a page of text and keep going the text 

will move over to another page. On many occasions it is possible to arrive at the end of a 

chapter, say, before the page is completed, and inserting a page break – simply by selecting 

the icon at that point – moves your cursor to the next fresh page. 

Find and Replace 

This is one of the most useful of all features of the Word package and one that can be used to 

great effect. Find and Replace is a system used to discover a selected phrase or word and 

replace it, either manually or automatically, with another. Have a look at the following 

document, one that includes the words ‘UK Lottery’ several times: 

 

We will assume that the writer has decided the phrase ‘UK Lottery’ would be better replaced 

by ‘National Lottery’. Find and Replace allows you to do this simply. With the ‘Home’ tab 

open you will find the feature at the far right of the screen, with two options – ‘Find’ and 

‘Replace’.  



The former, the ‘Find’ option, is used to search for words within a selected text. All you need 

to do is have the text open and the cursor on it, and select Find. You will see the following 

screen if you choose that option: 

 

If you were to search the document for ‘UK Lottery’ you would be prompted each time as to 

whether you wished to replace the phrase with another. However, selecting ‘Replace’ from 

the menu initially gives you this screen: 

 

There you have two boxes – one in which you enter the phrase you wish to find – ‘UK 

Lottery’ – and the second into which you type ‘National Lottery’, the phrase you are looking 

to replace it with. 

If you try it, then select ‘Replace All, the following will be displayed: 

 

That is telling you that 13 examples of the phrase ‘UK Lottery’ have been replaced with the 

chosen phrase ‘National Lottery’ – as you can now see in the example above. 



Chapter 2: Advance Features 

 

The comprehensive ability of Office 10 Word goes far beyond simply creating and editing 

documents with pictures and texts. If you select the Insert tab at the head of the page you will 

find a wealth of options, some quite detailed and others commonly used, that are useful and 

productive. 

Headers and Footers 

Mid way along the menu you will see the commonly used ‘header’ and footer’ icons; these 

are used to insert regular titles and details – for instance, an invoice design may be a standard 

that a company uses with a heading at the top and company details at the foot, or a letterhead 

may be custom made to look different with each sending. 

If you select either of these options you will be presented with a variety of options for 

standard header and footer styles, and the choices are surprisingly comprehensive in breadth 

– as shown in the following screen shot. 

 

We will take a look later at some of the more impressive template options that can be 

incorporated into Word, but the above is a demonstration of how to select a desired header or 

footer and incorporate it into your document. 

Create Tables 

Also useful, and again with the Insert tab, is the ability to create tables. Clicking the Table tab 

to the left of the menu will give you a variety of options including standard tables and the 

ability to insert an Excel worksheet, and these can be incorporated to great effect in many a 

document. Indeed, if you select tables and then the ‘quick tables’ tab you will be presented 

with a selection of standard calendars, lists, matrices and tables with subheadings, each of 

which will be of use in some form to those creating documents for business presentations. 

Insert References and Contents 

Perhaps the most interesting and useful feature is found under the ‘references’ tab. Click it to 

bring up the options and you will see many different instructions for you to choose from. The 

first and a commonly used option is that at the far left which gives you the option of inserting 

a table of contents. This is of particular use in business documents such as reports where the 

contents need to be highlighted, and the range of possible options is beneficial to the user. 

Choosing the style and substance of your table of contents, and the way it is aligned, means 

you are free to introduce your own look to the document, and make it as individual as 

possible. 

This section also allows the addition of footnotes and references in a variety of standard and 

specific formats – click the buttons for either and you will see the different possibilities – 



allowing for an in depth referencing of your work that is especially popular with students and 

those in the academic world. 

Tracking Changes 

It is also important that we look at the most used function in the review section, the ability to 

track changes. For editors this is an essential tool that is widely used, and it takes on a more 

important role with regard to the Office 10 version of Word in which more than one person is 

able to amend a document at the same time.  

Switch on the ‘Track Changes’ feature by clicking the icon once, then select ‘Track Changes’ 

in the options given. The icon will now be highlighted to show the feature is operational, and 

any alterations made will be shown in the text. 

In the example shown below I have made four changes to the text; on the third line the word 

‘expectation’ has been replaced with ‘interest’, at the end of the first paragraph another word 

has been entered, in the second paragraph the same has been done and the final sentence has 

been erased entirely. In each case the alteration is shown in red, the old word crossed out and 

the new one underlined, and a mark made in the left hand margin. 

 

 

These amendments are easy to make and, thanks to the ability to track changes, very simple 

to follow and allow for editors to highlight what has been amended in order that the writer 

can see clearly the difference in the text. To undo the changes, use the back arrow at the top 

of the screen. 

Having looked at the way we can insert tables and create references, and the page layout 

options, it is perhaps time to look at the many template options that can be used in Word. 



Chapter 3: Using Templates 

 

Templates are among the most useful features of Word, and provide a wide selection of 

standard options that are useful in terms of creating standard documents or producing 

individually styled ideas that are unique to your requirements. The template system is easy to 

use and versatile, and it will be among the most used features of the package. The number of 

templates available is enormous, and this can lead to time saving of a great degree when 

looking for various business forms. 

To have a look at the templates function, follow these steps: 

1: Open Microsoft Word in Office 10. 

2: Click on the Office Button, the circular icon in the top left hand corner of the screen. 

3: Select ‘new’ and you will see the following screen. 

 

 

This is the template selection and it offers a wealth of options for templates of different types 

of documents that can be used.  

Now select the ‘Installed Templates’ option and have a look at what is displayed. You will 

see many different types of available documents from blog posts to letters, resumes to fax 

layouts, each with different styles and attributes that you can choose. Pick one for a 

demonstration and have a look, and you will get an idea of the sort of layouts offered. 

Additionally there are many categories listed on the left of the screen that offer different 

varieties of forms and documents. These are available from the Microsoft Office Online 

selection, and the choice is comprehensive; select one, any for a demonstration, and you will 

see again a number of options offered, each of which is different in style and format. With 

everything from business cards to calendars through to receipts and minutes there is much to 

choose from making this a useful and easy to use tool. 

Particularly useful is the section titled ‘Forms’, which provides you with a  comprehensive 

selection of different templates for many forms that have an everyday use in the business and 

academic world, as well as everyday applications. The ‘Inventories’ section is also extremely 

useful for those who frequently use such items, and with additional templates including 

greetings cards, invitations, labels and envelopes, there is much variety to help in all 

situations. Clicking on a few sections and looking at what is available in the different 

template categories gives you an idea of the variety offered and how they can be formatted to 

your requirements. 



All of the available templates can be edited to your requirements, and when you save you can 

send it to the My Templates section for ease of use, thus building up your own collection of 

standard templates to your required designs. Colors, fonts and styles can be altered at will, 

and a good method of getting to grips with the package is to play with some of the available 

templates and the buttons across the top. 

Opening a blank worksheet from the selection allows you to create custom templates using 

the many features already described, and the presence of such a wide selection of already 

present templates is a bonus.  

There is also an official Microsoft selection of templates, with some that are created by other 

users who wish to share them, at http//:office.com/templates. Here you can browse through a 

wealth of designs and find one that suits your needs. 



Chapter 4: Microsoft Office Web App 

 

Among the most talked about aspects of the Office 10 package is the Web Apps function, a 

system that allows Word – and other – worksheets and documents to be opened and edited 

using the computer’s browser. The advantages of this are increased versatility and the ability 

to work on documents from anywhere, and the system has met with much acclaim among 

users of the new package. 

Using the system you can publish to the browser from the desktop and can specify those who 

are able to open and edit the document, thus giving added protection, while the look and feel 

of the document is somewhat more web-friendly than that of the desktop variety. 

The web version of Word appears as follows: 

 

One of the most interesting features is the marking of amendments, something that will be 

widely used in terms of Web Apps and a quick way of getting amendments and editing done 

online. The prospect for sharing of data and presentations is much brighter with this system. 

Using the Office Live Workspace feature it is possible to open a document and amend, 

marking the amendments and then sharing with another user. A neat touch is that whoever 

opens the document first is the one ‘in control’ of the changes that can be made to that 

particular worksheet. In addition, Microsoft SharedView is an alternative system whereby 

you can edit and view edits made by others in real time, a truly live system that allows you to 

control, as above, who can view and edit documents and to see what others are doing as they 

carry out their amendments. 

Bringing Office 10 to the web has allowed for an increase in the overall versatility of the 

system, and is a step forward in eliminating the need for desktop documents to be sent 

between users.  

The system is easy to use; simply open – or create – a worksheet and click the File tab. This 

gives you the standard backstage options, among which you should select Share and then 

Save to SkyDrive. This is a free storage system that is part of the Office Live package. Next 

you need to sign in using your Windows Live ID and password – if you don’t already have 

one the option is there to create one – and select the document required from the SkyDrive 

list that is displayed. 

If you now click View you will, after accepting terms of use, be able to edit, share or publish 

your document online. 

However, the Web Apps version of a document has certain limitations; there are many 

functions that you can amend, add and delete in the desktop version that you cannot on the 

web version, hence any in depth or serious editing will have to be done off line and the 

process repeated. However, this is very simple – with a document open in the browser you 



simply click the Open command and it will automatically open in the desktop version of 

Word; similarly, saving it returns you to the point you were at before. 

Despite its limited editing capability there is no doubt that the use of Web Apps – and there 

will be more functions available in time – will be popular and will open up the ways in which 

people use Word and Office 10, for there has long been a need for a web based version of the 

package. 



Chapter 5: Home Toolbar 

 
The HOME tab on the Ribbon is where you will be spending most of your time. This is 

where you’ll find all the basic features (Font, Styles, Colors, etc.). There five different 

sections here (Clipboard, Font, Paragraph, Styles, Editing). All but one of them (editing) has 

expanded features that you can access by clicking on the small box in the bottom right hand 

side (it has a diagonal arrow point down). To see what any button does, hover your mouse on 

top of it (without clicking) for two seconds and a small box will pop up that tells you what 

the button is for. 

A lot of the buttons are self-explanatory, and will not be explained in details. 

Clipboard 

Paste (CTRL + V) -- paste the contents of the Clipboard 

Cut (CTRL + X) -- cut selection and put it in the Clipboard 

Copy (CTRL + C) -- copy the selected text and put it in the Clipboard 

Format Painter (CTRL + Shift + C) -- copy formatting from one place and apply it to 

another 

 

Paragraph 

Font (CTRL + Shift + F) -- change the font style 



Font Size (CTRL + Shift + P) -- change the font size  

Grow Font (CTRL + >) -- increase the font size 

Shrink Font (CTRL +<) -- decrease the font size 

Clear Formatting -- clear all of the formatting from the selection, leaving only the plain text 

Bold (CTRL + B) -- holds selected text 

Italics (CTRL + I) -- italicizes selected text 

Underline (CTRL + U) -- underlines selected text 

Strikethrough -- draw a line through the middle of the selected text 

Subscript (CTRL + =) -- create small letters below the text of the baseline 

Superscript (CTRL + Shift + +) -- create small letters above the line of text 

Text Effects -- apply visual effects to the selected text such as shadow, glow, or reflection 

Text Highlight Color -- make the text look like it was marked with a highlighted pen 

Font Color -- Change the font color 

 

Paragraph 
Bullets -- start a bulleted list 

Numbering -- start a numbered list 

Multilevel List -- start a multilevel list 

Decrease Indent -- decreases the indent level of the paragraph 

Increase Indent -- increases the indent level of the paragraph 

Sort -- alphabetize the selected text or sort numerical data 

Show / Hide -- show the paragraph marks and other hidden formatting symbols 

Align Text Left (CTRL + L) -- align text to the left 

Align Text Right (CTRL + E) -- align text to the center 

Align Text Right (CTRL + R) -- align text to the right 

Justify (CTRL + J) -- align text to both the left and right margins, adding extra space 

between words as necessary  

Line and Paragraph Spacing -- change the spacing between lines of text 

Shading -- color the background behind the selected text or paragraph 

Bottom Border -- customize the borders of selected text 

 

One thing not on the toolbar is Double Spacing; if you want to double space, click on the 

small arrow in the bottom right corner of the Paragraph section to expand the toolbar into a 

large box. In the Paragraph dialog box, you will have several additional options, and two 

tabs. In the "Indents and Spacing" tab, Spacing is the bottom option. In this same box, you 

can change the line indention.  

 

Styles 
Change Styles -- change the set of styles, colors, fonts, and paragraph spacing used in the 

current document 

 

Editing 

Find (CTRL + F) -- find text or other content in the document 

Replace (CTRL + H) -- replace text in the document 

Select -- select text or objects in the document 



Chapter 6: Page Layout Toolbar 

 
To change the layout of your new document (Portrait vs. Landscape, Margins, Headers and 

Footers, Page Numbering, etc) go to the PAGE LAYOUT tab.  This tab is broke into five 

different sections (Themes, Page Setup, Page Background, Paragraph, Arrange). 

Themes 

Themes -- change the overall design of the document including colors, fonts, and effects 

Theme Colors -- change the colors of the current theme 

Theme Fonts -- change the font of the current theme 

Theme Effects -- change the effects of the current theme 

 

Margins 

Margins -- select the margin size for the entire document or one particular area 

Page Orientation -- switch the pages between portrait and landscape layouts 

Size -- choose the paper size of the current document 

Columns -- split the text into two or columns 

Breaks -- add page, section, or column breaks to the current document 

Hyphenation -- allows Word to insert hyphenations in words that have reached the end of 

the margin 

 



Page Background 

Watermark -- insert a faded text behind the current text 

Page Color -- choose the color for the background of the page 

Page Borders -- add or change the border around the page 

 

Paragraph 

Indent -- adjust the size of the indent on the left or right side of the page 

Spacing -- adjust the spacing between lines 

 

Arrange 

Position -- adjust the position of an object on the page 

Wrap Text -- change the way text wraps around an object 

Bring Forward -- bring a selected object forward so that it will not be hidden behind other 

objects 

Send Backward -- send an object backward so that it is behind other objects 

Selection Pane -- show the selection pane to help the individual object and change their order 

of viability 

Align -- align the edges of multiple selected objects 

Group -- group objects together so that they are treated as one object 

Rotate -- rotate or flip the selected object 



Chapter 7: Reference Toolbar 

 

Table of Contents 

Table of Contents -- add a table of contents to the documents 

Add Text -- add the current paragraph as an entry in the table of contents 

Update Table -- update the table of contents so that all the entries refer to the correct page 

 

Footnotes 

Insert Footnote (ALT + CTRL + F) -- add a footnote to the document 

Insert Endnote (ALT + CTRL + D) -- add an endnote to the document 

Next Footnote -- navigate to the next footnote in the document 

Show Notes -- Scroll the document to show where the footnotes and endnotes are located 

 

Citations & Bibliography 

Insert Citation -- cite a book, journal article, or other piece of information to the document 

Manage Sources -- view the list of all documents in the documents 

Style -- Choose the style of citation used in the document 

Bibliography -- add a bibliography, which lists all the sources cited 

 

Captions 
Insert caption -- add caption to a picture or other image 



Insert Table of Figures -- insert a table of figures into the document 

Update Table -- update the table of figures to include all of the entries in the document 

Cross-Reference -- refer to items such as headings, figures, and tables by inserting cross-

references such as, "see table below" 

 

Index 

Mark Entry (ALT + Shift + X) -- include the selected text in the index of the document 

Insert Index -- Insert an index into the document 

Update Index -- update the index so that all the entries refer to the correct page number 

 

Table of Authorities 

Mark Citation (ALT + Shift + I) -- add the selected text as an entry in the rabble of 

authorities  

Insert Table of Authorities -- Insert table of authorities into the document 

Update Table of Authorities -- update the table of authorities to include all of the citations 

in the document 



Chapter 8: Insert Toolbar 

 

Pages 

Cover Page -- Insert a fully formatted cover page 

Blank Page -- insert a new black page at the current position 

Page Break (CTRL + Return) -- start the next page of text at the current position 

 

Table 

Table -- insert or draw a table into the current document 

 

Illustrations 

Picture -- insert a picture from a file 

Clip Art -- insert a preinstalled clipart or search the Office Online resource for additional 

photos 

Shapes -- insert ready-made shapes, such as circles and triangles, into the document 

SmartArt -- insert a SmartArt graphic that visually illustrates a point 

Chart -- insert a chart that illustrates and compares data 

Screenshot -- insert a picture of any program that is not minimized in the task bar 

 

Links 



Hyperlink (CTRL + K) -- create a link to a web page, email address, picture, or program 

Bookmark -- create a bookmark to assign a name to a specific point in the document 

Cross-Reference -- refer to items such as heading, tables, and figures by inserting a cross 

reference such as, "see table below." 

 

Header & Footer 

Header -- edit the header of the document 

Footer -- edit the footer of a document 

Page Number -- insert page numbers to the document 

 

Text 
Text Box -- insert preformated text boxes 

Quick Parts -- insert reusable pieces of content, including fields, document properties such 

as titles and authors, or any preformated snippets that you create 

WordArt -- insert decorative art into your text 

Drop Cap -- Create a large capital letter at the beginning of the document 

Signature Line -- insert a signature line that specifies the individual who most sign the 

document 

Object -- insert an embedded object 

 

Symbols 

Equation (ALT + =) -- insert common mathematical equations or build your own equations 

using a library of math symbols 

Symbols -- insert symbols that are not on your keyboard 



Chapter 9: Picture Toolbar 

 

Once you insert a picture or shape, the editing tab on the ribbon will appear; when you 

deselect it, that tab will go away; to bring it back, just click on the photo once more, and the 

tab will appear again on the ribbon. 

 

Adjust 

Remove Background -- automatically remove unwanted portions of the picture  

Corrections -- improve the brightness, contrast, or sharpness of the picture 

Color -- change the color of the picture to improve quality or match document content 

Artistic Effects -- add artistic effects to the picture to make it look more like a sketch or 

painting 

Compress Pictures -- compress pictures in the document to reduce it's size 

Change Picture -- change to a different picture, preserving the formatting and size of the 

current picture 

Reset Picture -- discard all of the formatting changes you made to this picture 

 

Picture Style 

Picture Border -- specify the color, width, and line style of the outline of the selected shape 

Picture Effects -- apply a visual effect to the picture, such as shadow, glow, reflection or 3D 

rotation 



Picture Layout -- convert the selected pictures to a SmartArt graphic to easily arrange, 

caption, and resize the picture 

 

Arrange 

Object Position -- position the selected object on the page 

Wrap Text -- change the way twit wraps around the selected object 

Bring Forward -- bring sleeted object forward so that it is hidden by fewer object that are in 

front of it 

Send Backward -- send selected text backward so that is behind more objects 

Selection Pane -- show the Selection Pane to help select individual objects and to chain their 

order of visibility  

Align -- align the edges of multiple selected objects 

Group -- group objects together so that they can be treated like a single object 

Rotate -- rotate or flip the selected object 

 

Size 

Crop -- crop the picture or apply various cropping parts 

Shape Height -- change the height of the shape or picture  

Shape Width -- change the width of the document 



Chapter 10: Mailings Toolbar 

 

Create 

Envelopes -- create and print envelopes 

Labels -- create and print labels 

 

Start Mail Merge 

Start Mail Merge -- start a mail merge to create a form letter which you intend to print or e-

mail multiple times, sending each copy to a different person 

Select Recipients -- choose the people that you intend to send the letter to 

Edit Recipients List -- Make changes to the list of recipients 

 

Write & Insert Fields 

Highlight Merge Fields -- highlight the fields you have inserted into the document  

Address Block -- add an address to your letter 

Greeting Line -- and a greeting ouch as "Dear <insert persons name>"  

Insert Merge Field -- add any field from your recipient list to the document, such as "last 

name," "home phone," "company name," etc 

Rules -- Specify rules to add decision-making ability to the mail merge 

Match Fields -- allows you to tell Word the meaning of different fields in your recipient list 

Update Labels -- If you are creating labels, update all labels in the document to use 

information from the list 

 

Preview Results 



Preview Results -- replace the merge fields in your document with actual data from your 

recipient list so you can see what it looks like 

Go to Record -- Preview a specific record in the recipient list 

Find Recipient -- find and preview a specific record in the recipient list by searching the text 

Auto Check for Errors (ALT + Shift + K) -- Specify how to handle errors that occur during 

the mail merge 

 

Finish 

Finish and Merge -- Complete the mail merge 
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Proofing 

Spelling and grammar (F7) -- check the spelling and grammar in the document 

Research (ALT + Click) -- search through reference materials (such as dictionaries, 

encyclopedias, and translation services) 

Thesaurus (Shift F7) --  suggests other words with a similar meaning to the word you have 

selected 

Word Count -- find the number of words, characters, and lines in the document 

 

Language 

Translate -- translate a word or paragraph into a different language 

Language -- select language options 

 

Comments 

Insert Comment -- add a comment about a selection 

Delete Comment -- delete the selected comment 

Previous Comment -- navigate to the previous comment in the document 

Next Comment -- navigate to the next comment in the document 

 

Tracking 



Track Changes (CTRL + Shift + E) -- track all changes made to the document, including 

insertions, deletions, and formatting changes 

Display for Review -- choose how to view the proposed changes to the document 

Show Markup -- choose the kind of markup shown in the document 

Reviewing Pane -- Show revisions in a separate window 

 

Changes 

Accept -- accept the current view and move to the next proposed change 

Reject -- reject the current change and move to the next proposed change 

Previous -- navigate to the previous revision so that you can accept or reject it 

Next -- navigate to the next revision so you can reject or accept it 

 

Compare 

Compare -- compare multiple versions of a document 

 

Protect 

Block Authors -- block other authors from editing text 

Restrict Editing -- restrict how people edit or format different parts of the document 
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Document Views 

Page Layout -- view the document as it will appear on the printed page 

Full Screen Reading -- view the document in full screen reading view to maximize the space 

available for reading 

Web Layout -- view the document as it would look like as a web page 

Outline View -- view document as an outline to see outlining tools 

Draft View -- view document as a draft for quick editing 

 

Show 

Ruler -- view a ruler to measure the placement of objects in the document 

Guidelines -- guidelines help you align objects in the document 

Navigation Pane -- allows you to navigate through the document by heading, page, or 

searching for text/object 

 

Zoom 

Zoom -- show the zoom dialog box to specify the zoom level of the document 

100% -- zoom the document back to 100% 

One Page -- zoom the document so the entire page fits in one window 

Two Pages -- zoom so that the document fits to pages in the window 



Page Width -- zoom so that the width of the page matches the width of the window 

 

Window 

New Window -- opens a new window containing your current document 

Arrange All -- tiles all open windows so that they appear side-by-side on your screen 

Split -- split the current document into two parts so that you can see different sections of the 

document at the time 

View Side by Side -- view two documents side by side so that you can compare the contents 

of each 

Synchronous Scrolling -- synchronize two documents so that they scroll together 

Reset Window Position -- resets the window position of documents being compared side-

by-side so the share the screen equally  

Switch View -- switch to a different open document 

 

Macros 

Macros -- view the list of macros, from which you can run, create, or delete a macro 



Appendix: 

Shortcut Commands 

Command Name                  Shortcut Keys 

All Caps                      CTRL+SHIFT+A 

Annotation                    ALT+CTRL+M 

App Maximize                  ALT+F10 

App Restore                   ALT+F5 

Apply Heading1                ALT+CTRL+1 

Apply Heading2                ALT+CTRL+2 

Apply Heading3                ALT+CTRL+3 

Apply List Bullet             CTRL+SHIFT+L 

Auto Format                   ALT+CTRL+K 

Auto Text                     F3 or ALT+CTRL+V 

Bold                          CTRL+B or CTRL+SHIFT+B 

Bookmark                      CTRL+SHIFT+F5 

Browse Next                   CTRL+PAGE DOWN 

Browse Previous               CTRL+PAGE UP 

Browse Sel                    ALT+CTRL+HOME 

Cancel                        ESC 

Center Para                   CTRL+E 

Change Case                   SHIFT+F3 

Char Left                     LEFT 

Char Left Extend              SHIFT+LEFT 

Char Right                    RIGHT 

Char Right Extend             SHIFT+RIGHT 

Clear                         DELETE 

Close or Exit                 ALT+F4 

Close Pane                    ALT+SHIFT+C 

Column Break                  CTRL+SHIFT+ENTER 

Column Select                 CTRL+SHIFT+F8 

Copy                          CTRL+C or CTRL+INSERT 

Copy Format                   CTRL+SHIFT+C 

Copy Text                     SHIFT+F2 

Create Auto Text              ALT+F3 

Customize Add Menu            ALT+CTRL+= 

Customize Keyboard            ALT+CTRL+NUM + 

Customize Remove Menu         ALT+CTRL+- 

Cut                           CTRL+X or SHIFT+DELETE 

Date Field                    ALT+SHIFT+D 

Delete Back Word              CTRL+BACKSPACE 

Delete Word                   CTRL+DELETE 

Dictionary                    ALT+SHIFT+F7 

Do Field Click                ALT+SHIFT+F9 

Doc Close                     CTRL+W or CTRL+F4 

Doc Maximize                  CTRL+F10 

Doc Move                      CTRL+F7 

Doc Restore                   CTRL+F5 



Doc Size                      CTRL+F8 

Doc Split                     ALT+CTRL+S 

Double Underline              CTRL+SHIFT+D 

End of Column                 ALT+PAGE DOWN 

End of Column                 ALT+SHIFT+PAGE DOWN 

End of Doc Extend             CTRL+SHIFT+END 

End of Document               CTRL+END 

End of Line                   END 

End of Line Extend            SHIFT+END 

End of Row                    ALT+END 

End of Row                    ALT+SHIFT+END 

End of Window                 ALT+CTRL+PAGE DOWN 

End of Window Extend          ALT+CTRL+SHIFT+PAGE DOWN 

Endnote Now                   ALT+CTRL+D 

Extend Selection              F8 

Field Chars                   CTRL+F9 

Field Codes                   ALT+F9 

Find                          CTRL+F 

Font                          CTRL+D or CTRL+SHIFT+F 

Font Size Select              CTRL+SHIFT+P 

Footnote Now                  ALT+CTRL+F 

Go Back                       SHIFT+F5 or ALT+CTRL+Z 

Go To                         CTRL+G or F5 

Grow Font                     CTRL+SHIFT+. 

Grow Font One Point           CTRL+] 

Hanging Indent                CTRL+T 

Header Footer Link            ALT+SHIFT+R 

Help                          F1 

Hidden                        CTRL+SHIFT+H 

Hyperlink                     CTRL+K 

Indent                        CTRL+M 

Italic                        CTRL+I or CTRL+SHIFT+I 

Justify Para                  CTRL+J 

Left Para                     CTRL+L 

Line Down                     DOWN 

Line Down Extend              SHIFT+DOWN 

Line Up                       UP 

Line Up Extend                SHIFT+UP 

List Num Field                ALT+CTRL+L 

Lock Fields                   CTRL+3 or CTRL+F11 

Macro                         ALT+F8 

Mail Merge Check              ALT+SHIFT+K 

Mail Merge Edit Data Source   ALT+SHIFT+E  

Mail Merge to Doc             ALT+SHIFT+N 

Mail Merge to Printer         ALT+SHIFT+M 

Mark Citation                 ALT+SHIFT+I 

Mark Index Entry              ALT+SHIFT+X 

Mark Table of Contents Entry  ALT+SHIFT+O 

Menu Mode                     F10 

Merge Field                   ALT+SHIFT+F 



Microsoft Script Editor       ALT+SHIFT+F11 

Microsoft System Info         ALT+CTRL+F1 

Move Text                     F2 

New                           CTRL+N 

Next Cell                     TAB 

Next Field                    F11 or ALT+F1 

Next Misspelling              ALT+F7 

Next Object                   ALT+DOWN 

Next Window                   CTRL+F6 or ALT+F6 

Normal                        ALT+CTRL+N 

Normal Style                  CTRL+SHIFT+N or ALT+SHIFT+CLEAR (NUM 5) 

Open                          CTRL+O or CTRL+F12 or ALT+CTRL+F2 

Open or Close Up Para         CTRL+0 

Other Pane                    F6 or SHIFT+F6 

Outline                       ALT+CTRL+O 

Outline Collapse              ALT+SHIFT+- or ALT+SHIFT+NUM - 

Outline Demote                ALT+SHIFT+RIGHT 

Outline Expand                ALT+SHIFT+= 

Outline Expand                ALT+SHIFT+NUM + 

Outline Move Down             ALT+SHIFT+DOWN 

Outline Move Up               ALT+SHIFT+UP 

Outline Promote               ALT+SHIFT+LEFT 

Outline Show First Line       ALT+SHIFT+L 

Overtype                      INSERT 

Page                          ALT+CTRL+P 

Page Break                    CTRL+ENTER 

Page Down                     PAGE DOWN 

Page Down Extend              SHIFT+PAGE DOWN 

Page Field                    ALT+SHIFT+P 

Page Up                       PAGE UP 

Page Up Extend                SHIFT+PAGE UP 

Para Down                     CTRL+DOWN 

Para Down Extend              CTRL+SHIFT+DOWN 

Para Up                       CTRL+UP 

Para Up Extend                CTRL+SHIFT+UP 

Paste                         CTRL+V or SHIFT+INSERT 

Paste Format                  CTRL+SHIFT+V 

Prev Cell                     SHIFT+TAB 

Prev Field                    SHIFT+F11 or ALT+SHIFT+F1 

Prev Object                   ALT+UP 

Prev Window                   CTRL+SHIFT+F6 or ALT+SHIFT+F6 

Print                         CTRL+P or CTRL+SHIFT+F12 

Print Preview                 CTRL+F2 or ALT+CTRL+I 

Proofing                      F7 

Redo                          ALT+SHIFT+BACKSPACE 

Redo or Repeat                CTRL+Y or F4 or ALT+ENTER 

Repeat Find                   SHIFT+F4 or ALT+CTRL+Y 

Replace                       CTRL+H 

Reset Char                    CTRL+SPACE or CTRL+SHIFT+Z 

Reset Para                    CTRL+Q 



Revision Marks Toggle         CTRL+SHIFT+E 

Right Para                    CTRL+R 

Save                          CTRL+S or SHIFT+F12 or ALT+SHIFT+F2 

Save As                       F12 

Select All                    CTRL+A or CTRL+CLEAR (NUM 5) or CTRL+NUM 5 

Select Table                  ALT+CLEAR (NUM 5) 

Show All                      CTRL+SHIFT+8 

Show All Headings             ALT+SHIFT+A 

Show Heading1                 ALT+SHIFT+1 

Show Heading2                 ALT+SHIFT+2 

Show Heading3                 ALT+SHIFT+3 

Show Heading4                 ALT+SHIFT+4 

Show Heading5                 ALT+SHIFT+5 

Show Heading6                 ALT+SHIFT+6 

Show Heading7                 ALT+SHIFT+7 

Show Heading8                 ALT+SHIFT+8 

Show Heading9                 ALT+SHIFT+9 

Shrink Font                   CTRL+SHIFT+, 

Shrink Font One Point         CTRL+[ 

Small Caps                    CTRL+SHIFT+K 

Space Para1                   CTRL+1 

Space Para15                  CTRL+5 

Space Para2                   CTRL+2 

Spike                         CTRL+SHIFT+F3 or CTRL+F3 

Start of Column               ALT+PAGE UP 

Start of Column               ALT+SHIFT+PAGE UP 

Start of Doc Extend           CTRL+SHIFT+HOME 

Start of Document             CTRL+HOME 

Start of Line                 HOME 

Start of Line Extend          SHIFT+HOME 

Start of Row                  ALT+HOME 

Start of Row                  ALT+SHIFT+HOME 

Start of Window               ALT+CTRL+PAGE UP 

Start of Window Extend        ALT+CTRL+SHIFT+PAGE UP 

Style                         CTRL+SHIFT+S 

Subscript                     CTRL+= 

Superscript                   CTRL+SHIFT+= 

Symbol Font                   CTRL+SHIFT+Q 

Thesaurus                     SHIFT+F7 

Time Field                    ALT+SHIFT+T 

Toggle Field Display          SHIFT+F9 

Toggle Master Subdocs         CTRL+\  

Tool                          SHIFT+F1 

Un Hang                       CTRL+SHIFT+T 

Un Indent                     CTRL+SHIFT+M 

Underline                     CTRL+U or CTRL+SHIFT+U 

Undo                          CTRL+Z or ALT+BACKSPACE 

Unlink Fields                 CTRL+6 or CTRL+SHIFT+F9 

Unlock Fields                 CTRL+4 or CTRL+SHIFT+F11 

Update Auto Format            ALT+CTRL+U 



Update Fields                 F9 or ALT+SHIFT+U 

Update Source                 CTRL+SHIFT+F7 

VBCode                        ALT+F11 

Web Go Back                   ALT+LEFT 

Web Go Forward                ALT+RIGHT 

Word Left                     CTRL+LEFT 

Word Left Extend              CTRL+SHIFT+LEFT 

Word Right                    CTRL+RIGHT 

Word Right Extend             CTRL+SHIFT+RIGHT 

Word Underline                CTRL+SHIFT+W. 



Conclusion 
 

This eBook is designed to give you an overview of the system and how it works, and to guide you 

through some of the more useful basic features that Word Office 10 can offer you, and it is essential 

that you understand there is much more to be discovered in what is a very useful and extremely 

versatile package. For business users there is much to be gained from the new system, and for the 

academic user the methods of including references, tables and diagrams is endlessly usable. Office 10 

has taken Microsoft Word and improved on what was a very good package by expanding its user base 

to those who wish to access it from the web based version, a sensible move that users have demanded 

for some time. 
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